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Preface

About This Guide

This guide explains how to install ISE™ Design Suite 10.1, which includes the Integrated 
Software Environment (ISE) , ChipScope™ Pro, Xilinx Embedded Development Kit (EDK), 
DSP Tools (including AccelDSP™ and System Generator), and PlanAhead™/PlanAhead 
Lite. It also describes how to use Xilinx® online documentation. 

Information on technical support and known issues for ISE Design Suite 10.1 software are 
also included.

Guide Contents
This manual contains the following chapters:

• Chapter 1, “What’s New in ISE Design Suite 10.1”

• Chapter 2, “Known Issues for ISE Design Suite Products”

• Chapter 3, “Operating System and Architecture Support”

• Chapter 4, “Using the Xilinx Product Registration and Download Site”

• Chapter 5, “Installation”

• Chapter 6, “Product-Specific Installation, Registration, and Usage Notes”

• Chapter 7, “Technical Services and Support”

• Appendix A, “License Agreements”

Additional Resources
To find additional documentation, see the Xilinx website at:

http://www.xilinx.com/support/software_manuals.htm

To search the Answer Database of silicon, software, and IP questions and answers, or to 
create a technical support WebCase, see the Xilinx website at:

http://www.xilinx.com/support.

To obtain the current version of the USB Cable Installation Guide, see the Xilinx website at:

http://www.xilinx.com/support/documentation/user_guides/ug344.pdf
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To obtain the current version of the data sheet for Platform Cable USB, see the Xilinx 
Website at: 

http://www.xilinx.com/support/documentation/data_sheets/ds300.pdf

To obtain the current version of the data sheet for Parallel Cable IV, see the Xilinx Website 
at:

http://www.xilinx.com/support/documentation/data_sheets/ds097.pdf

Conventions
This document uses the following conventions. An example illustrates each convention.

Typographical
The following typographical conventions are used in this document:

Convention Meaning or Use Example

Courier font
Messages, prompts, and 
program files that the system 
displays

speed grade: - 100

Courier bold
Literal commands that you enter 
in a syntactical statement

ngdbuild design_name

Helvetica bold

Commands that you select from 
a menu

File → Open

Keyboard shortcuts Ctrl+C

Italic font

Variables in a syntax statement 
for which you must supply 
values

ngdbuild design_name

References to other manuals
See the Development System 
Reference Guide for more 
information.

Emphasis in text
If a wire is drawn so that it 
overlaps the pin of a symbol, the 
two nets are not connected.

Square brackets    [  ]

An optional entry or parameter. 
However, in bus specifications, 
such as bus[7:0], they are 
required.

ngdbuild [option_name] 
design_name

Braces    {  }
A list of items from which you 
must choose one or more

lowpwr ={on|off}

Vertical bar    |
Separates items in a list of 
choices

lowpwr ={on|off}
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Online Document
The following conventions are used in this document:

Vertical ellipsis
.
.
.

Repetitive material that has 
been omitted

IOB #1: Name = QOUT’ 
IOB #2: Name = CLKIN’
.
.
.

Horizontal ellipsis  . . .
Repetitive material that has 
been omitted

allow block  block_name loc1 
loc2 ... locn;

Convention Meaning or Use Example

Convention Meaning or Use Example

Blue text Cross-reference link to a location 
in the current document

See the section “Additional 
Resources” for details.

Refer to “Title Formats” in 
Chapter 1 for details.

Red text
Cross-reference link to a location 
in another document 

See Figure 2-5 in the Virtex-II 
Platform FPGA User Guide.

Blue, underlined text Hyperlink to a website (URL)
Go to http://www.xilinx.com 
for the latest speed files.
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Chapter 1

What’s New in ISE Design Suite 10.1

This chapter describes how to access the list of new features that are included in the 
products that comprise ISE™ Design Suite 10.1.

What’s New

MS Windows Only
You can view the What’s New documentation by selecting Start > Programs > Xilinx ISE 
Design Suite 10.1 > [product name] > Documentation > What’s New, where [product 
name] is the name of any of the products you have installed, such as ISE, ChipScope Pro™, 
DSP_Tools, EDK, and PlanAhead™.

MS Windows and Linux
The What’s New documentation is contained in a file called whatsnew.htm, which is 
located in the home directory of each product that the ISE Design Suite 10.1 Installer 
creates under the ISE Design Suite 10.1 home directory (default: Xilinx10.1). Possible 
directory names are:

• ChipScope

• DSP_Tools

• EDK

• ISE

• PlanAhead

Note: All of the What’s New files referenced above are identical, and contain information on all of the 
products included in ISE Design Suite 10.1.
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Chapter 2

Known Issues for ISE Design Suite 
Products

This chapter describes how to access the Known Issues for ISE™ Design Suite 10.1.

Known Issues
Xilinx Technical Publication 026 contains information on Known Issues for ISE Design 
Suite 10.1:

Known Issues 10.1
ISE Design Suite 10.1 Release Notes www.xilinx.com 13
10.1

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?topic=knownissues&ver=10.1


Chapter 2: Known Issues for ISE Design Suite Products
R

14 www.xilinx.com ISE Design Suite 10.1 Release Notes
10.1



R

Chapter 3

Operating System and Architecture 
Support

This chapter describes the operating systems and architectures ISE™ Design Suite 10.1 
supports. This chapter comprises the following sections:

• “Operating Systems”

• “Architectures”

Operating Systems
ISE Design Suite 10.1 supports three operating systems, which are Microsoft Windows®, 
Red Hat® Enterprise Linux, and SUSE Linux Enterprise. 

MS Windows
The following table lists MS Windows support.

Table 3-1: MS Windows Support

XP Professional Vista Business

Product 32-bit 64-bit 32-bit 64-bit

ISE Foundation Yes Yes Yes Yes

ISE Foundation with ISE Simulator Yes

Yes
Note: To use ISE Simulator 
on 64-bit MS Windows, you 
must run the 32-bit version 
of Project Navigator, which 
is automatically installed 
with the 64-bit versions of 

ISE Design Suite.

Yes

Yes
Note: To use ISE Simulator 

on 64-bit Vista, you must run 
the 32-bit version of Project 

Navigator, which is 
automatically installed with 

the 64-bit versions of ISE 
Design Suite.

ISE WebPACK Yes No Yes No

ChipScope™ Pro and Serial I/O Toolkit Yes Yes Yes Yes

PlanAhead™ Yes Yes Yes Yes

Embedded Development Kit (EDK) Yes No Yes No

System Generator for DSP and AccelDSP™ Yes No No No
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Red Hat Enterprise Linux
The following table lists Red Hat Enterprise Linux support.

SUSE Linux Enterprise
The following table lists SUSE Linux Enterprise 10 support.

Table 3-2: Red Hat Enterprise Linux Support

4 Workstation 5 Desktop

Product 32-bit 64-bit 32-bit 64-bit

ISE Foundation Yes Yes Yes Yes

ISE Foundation with ISE Simulator Yes Yes Yes Yes

ISE WebPACK Yes No Yes No

ChipScope Pro and Serial I/O Toolkit Yes Yes Yes Yes

PlanAhead Yes Yes Yes Yes

Embedded Development Kit (EDK) Yes Yes Yes Yes

System Generator for DSP and AccelDSP No No No No

Table 3-3: SUSE Linux Enterprise 10 Support

Product 32-bit 64-bit

ISE Foundation Yes Yes

ISE Foundation with ISE Simulator Yes Yes

ISE WebPACK Yes No

ChipScope Pro and Serial I/O Toolkit Yes Yes

PlanAhead Yes Yes

Embedded Development Kit (EDK) Yes Yes

System Generator for DSP and AccelDSP No No
16 www.xilinx.com ISE Design Suite 10.1 Release Notes
10.1



Architectures
R

Architectures
ISE Design Suite 10.1 supports three architecture families, which are Virtex™, Spartan™, 
and CPLD. 

Virtex
The following tables list Virtex support.

Table 3-4: Virtex Support

Product Virtex -E -II -II Pro -II Pro X -4 -5

ISE Foundation Yes Yes Yes Yes Yes Yes Yes

ISE Foundation with ISE Simulator Yes Yes Yes Yes Yes Yes Yes

WebPACK

V50,

V100,

V150,

V200,

V300,

V400,

V600

V50E,

V100E,

V200E,

V300E,

V400E,

V405E,

V600E

2V40,

2V80,

2V250,

2V500

2VP2,

2VP4,

2VP7,

2VP20,

2VP30

No

4VLX15,

4VLX25,

4VSX25,

4VFX12

5VLX20T,

5VLX30,

5VLX50,

5VLX30T,

5VLX50T,

5VFX30T

ChipScope Pro Yes Yes Yes Yes Yes Yes Yes

ChipScope Pro Serial I/O Toolkit No No No No No Yes Yes

PlanAhead No No Yes Yes Yes Yes Yes

Embedded Development Kit (EDK) Yes Yes
2V250

or

larger
Yes No Yes

Yes
Note: FXT 

- Early 
Access 

Support 
with full 
support 

coming in 
a 10.1 

Service 
Pack

System Generator for DSP and AccelDSP Yes Yes Yes Yes Yes Yes Yes
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Spartan
The following tables list Spartan support.

Table 3-5: Virtex Aerospace and Defense Support

Defense QPro
Aerospace QPro-R
Radiation Tolerant

Product Virtex Q -E Q -II Q -II Pro Q -4 Q Virtex QR -II QR -4 QR

ISE Foundation Yes Yes Yes Yes Yes Yes Yes
4VLX200,

4VSX55,

4VGX60

ISE Foundation with ISE Simulator Yes Yes Yes Yes Yes Yes Yes
4VLX200,

4VSX55,

4VGX60

ISE WebPACK
V100,

V300,

V600

V600E No No No
VR300,

VR600
No No

ChipScope Pro Yes Yes Yes Yes Yes Yes Yes Yes

ChipScope Pro Serial I/O Toolkit No No No No No No No No

PlanAhead No No Yes Yes Yes No Yes
4VLX200,

4VSX55,

4VGX60

Embedded Development Kit (EDK) Yes Yes Yes Yes

coming 
in a 10.1 
Service 

Pack

Yes Yes

coming in 
a 10.1 

Service 
Pack

System Generator for DSP and AccelDSP No No No No No No No No

Table 3-6: Spartan Support

Product -II -IIE -3 -3E -3L -3A -3AN -3A DSP

ISE Foundation Yes Yes Yes Yes Yes Yes Yes Yes

ISE Foundation with ISE Simulator Yes Yes Yes Yes Yes Yes Yes Yes

ISE WebPACK Yes Yes

3S50,

3S200,

3S400,

3S1000,

3S1500

Yes
3S1000L,
3S1500L

Yes Yes Yes

ChipScope Pro Yes Yes Yes Yes Yes Yes Yes Yes

ChipScope Pro Serial I/O Toolkit No No No No No No No No

PlanAhead No No Yes Yes Yes Yes Yes Yes

Embedded Development Kit (EDK)
2S50

or

larger
Yes Yes Yes No Yes Yes Yes

System Generator for DSP and AccelDSP Yes Yes Yes Yes Yes Yes Yes Yes
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CPLD
The following tables list CPLD support.

Table 3-7: Spartan Automotive Support

Product -IIE -3 -3E -3A -3A DSP

ISE Foundation Yes Yes Yes coming in 10.1 
Service Pack 1

coming in 10.1 
Service Pack 1

ISE Foundation with ISE Simulator Yes Yes Yes coming in 10.1 
Service Pack 1

coming in 10.1 
Service Pack 1

ISE WebPACK Yes Yes Yes coming in 10.1 
Service Pack 1

coming in 10.1 
Service Pack 1

ChipScope Pro Yes Yes Yes coming in 10.1 
Service Pack 1

coming in 10.1 
Service Pack 1

ChipScope Pro Serial I/O Toolkit No No No No No

PlanAhead No Yes Yes
coming in 10.1 
Service Pack 1

coming in 10.1 
Service Pack 1

Embedded Development Kit (EDK) Yes Yes Yes coming in a 10.1 
Service Pack

coming in a 10.1 
Service Pack

System Generator for DSP and AccelDSP
coming in a 
10.1 Service 

Pack

coming in a 
10.1 Service 

Pack

coming in a 
10.1 Service 

Pack

coming in a 10.1 
Service Pack

coming in a 10.1 
Service Pack

Table 3-8: 9500 Support

Product 9500 9500XL 9500XV Automotive 9500XL

ISE Foundation Yes Yes Yes Yes

ISE Foundation with ISE Simulator Yes Yes Yes Yes

ISE WebPACK Yes Yes Yes Yes

ChipScope Pro and Serial I/O Toolkit No No No No

PlanAhead No No No No

Embedded Development Kit (EDK) No No No No

System Generator for DSP and AccelDSP No No No No
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Table 3-9: CoolRunner Support

Product CoolRunner XPLA3 CoolRunner-II Automotive CoolRunner-II

ISE Foundation Yes Yes Yes

ISE Foundation with ISE Simulator Yes Yes Yes

ISE WebPACK Yes Yes Yes

ChipScope Pro and Serial I/O Toolkit No No No

PlanAhead No No No

Embedded Development Kit (EDK) No No No

System Generator for DSP and AccelDSP No No No
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Chapter 4

Using the Xilinx Product Registration 
and Download Site

This chapter describes the functionality of the Product Registration and Download Site. It 
includes the following sections:

• “User Types and Actions”

• “Accessing the Product Registration and Download Site”

• “Registering and Downloading Products”

• “Administering Accounts”

User Types and Actions
There are three user types for the Product Registration and Download Site, which are 
customer account administrator, end user, and evaluation user. 

Note: Every account must have at least one customer account administrator, even if that account 
contains only one person.

Customer Account Administrator
An example of a typical customer account administrator is a CAD tools administrator. At 
least one customer account administrator is required for each account, but an account can 
have more than one customer account administrator. 

A customer account administrator is the “Ship To” contact that is identified during the 
product ordering process. That person will receive an email with instructions on how to 
register and download the products that were purchased. It is important that the customer 
account administrator follow the link in the email, as it will ensure that he can obtain 
access to the purchased products.

Customer account administrators can manage multiple accounts, can assign account 
administration privileges to one or more end users of the account, and can act as an end 
user.

End User
An example of an end user is an engineer or design team member. An end user is added to 
the account by the customer account administrator and is entitled to a single seat of one or 
more of the ISE Design Suite products that have been purchased. End users can generate a 
Registration ID, download products electronically, and request an ISE™ Design Suite 10.1 
DVD.
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Evaluation User
An evaluation user is someone who would like to test-drive ISE Design Suite 10.1 
products. Evaluation users can generate a Registration ID, download evaluation versions 
of products, and request an ISE Design Suite 10.1 DVD, at 
http://www.xilinx.com/register.

Note: A customer who is already licensed for ISE Design Suite products may test-drive 
other ISE Design Suite products by accessing their account on the Product Registration and 
Download Site and requesting one or more products to evaluate.

Accessing the Product Registration and Download Site
There are two ways to access the site.

• If you purchased products, follow the link included in your order confirmation email.

• If you want to evaluate ISE Design Suite 10.1 products, go to 
http://www.xilinx.com/register.

If you have not created an account, follow the instructions for creating an account. After 
signing in, you are taken to the Product Registration and Download main page.
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Registering and Downloading Products
From the Product Registration and Download main page you begin the process to generate 
a Registration ID and download purchased, evaluation, or free ISE Design Suite products. 

Note: If you are not a customer account administrator then you will not see the Acct Admin tab. 

Registering 10.1 Products and Generating a Registration ID
To register 10.1 products and generate a Registration ID, perform the following steps:

1. Pull down the Account drop-down list and select your desired account. This selection 
will not be available if you are only entitled to evaluation or free products.

2. Pull down the Release No. drop-down list and select 10.1. This selection will only be 
available if you are entitled to purchased products, since evaluation products are only 
available for the latest release. If you need older products, see “Registering and 
Downloading Previous Releases”.

Your selected account and release number displays at the top of the Select Products 
section, which displays the products you can register and download.

X-Ref Target - Figure 4-1

Figure 4-1: Select Products Screen
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3. Select the products you want to register.

Note: If you are not entitled to any purchased or licensed Xilinx products then you will not see the 
Entitled Products section.

4. Click the Next button.

A Registration ID is generated and an email confirmation will be sent to you. You are 
taken to the next page in the registration and download process, which displays your 
generated Registration ID. You will need the Registration ID during the installation 
process.
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Downloading 10.1 Products

There are two methods available for downloading ISE Design Suite 10.1 products:

• WebInstall Client: downloads a single ~50 MB executable installer providing web 
based installation of all your included products.

• Files Individually: single-product, single-file downloads of your included products.

X-Ref Target - Figure 4-2

Figure 4-2: Download Products Screen
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Downloading WebInstall Client

The WebInstall Client is the recommended method of installation. To download using this 
method, click the DOWNLOAD button. 

Downloading Individual Products

To download products separately, follow these steps:

1. View the list of products by clicking the + button next to Download Files Individually.

2. Click the Download link next to the product you want to download.

The Download Manager opens. 

3. Follow the Download Manager instructions.

4. Repeat the above steps for each product you want to download.

Ordering a DVD

To receive an ISE Design Suite 10.1 DVD, click the Request a DVD link in the Download 
section.

Note: If you purchased a product, you can receive the DVD free of charge. If you only registered 
evaluation or free (WebPACK) versions of the product, then there will be a charge for the DVD.

Accessing Documentation

To access the ISE Design Suite 10.1 Release Notes and Installation Guide, What’s New in ISE 
Design Suite 10.1, and Read Me First documents, click on the provided links in the 
Documentation section.

Registering Additional Products
You can visit the Product Registration and Download Site at a later time to register and 
download additional ISE Design Suite products. The Select Products section displays all 
of your entitled, evaluation, and free products. A checkmark will be in the box beside the 
products already registered and the box will be empty for products not registered. After 
you add and register your new products, a new Registration ID will be regenerated for 
you. This new Registration ID comprehends the previously registered products plus the 
new products you just selected and registered. An updated registration confirmation email 
will be sent to you.

Registering and Downloading Previous Releases
If you have purchased products of version 9.2 or earlier, you can register and download 
them using the Product Registration and Download Site. To register and download the 
older products, perform the following steps:

1. Pull down the Account drop-down list and select your desired account. This selection 
will not be available if you are only entitled to evaluation or free products.

2. Pull down the Release No. drop-down list and select the desired release. 

Your selected account and release number displays at the top of the Select Products 
section, which displays the products you can register and download.
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3. Click the link of the product you want to register.

A page appears that gives you the option to register your product and displays the 
available downloads associated with the product.

4. Click the Get REG ID button.

The Registration ID appears. You will need the Registration ID during the installation 
process.

5. In the Available Downloads section, click the link of the documentation or the single-
product single-file download you want. 

6. Repeat the above steps for each product you want to register and download.
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Administering Accounts
To access customer account administration activities, click the Acct Admin tab on the main 
Product Registration and Download page.

X-Ref Target - Figure 4-3

Figure 4-3: Account Administrator Screen
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To perform administrator activities, do the following steps:

1. Pull down the Account drop-down list and select your desired account. 

2. Pull down the Release No. drop-down list and select your desired release. 

Your selected account and release number displays at the top of the section detailing 
product usage.

Product Usage
Product usage is shown differently in two sections, View By Products and View By 
Users.

View By Products

The View By Products section enables you to determine which users have registered seats 
of software on a product-by-product basis. It displays:

Product Entitlements - name of the ISE Design Suite products you purchased

Used - number of seats registered

Available - number of seats available for registration 

Total - number of seats purchased

You can sort in ascending or descending order by clicking on the respective column header. 
An arrow shows how rows are sorted.

To see who is registered for each product and the associated Registration ID, click the View 
End Users link below the product name.

View By Users

The View By Users section enables you to determine which seats of products a user has 
registered on a user-by-user basis. It displays:

Name - first and last name of each user 

Role - role of the user (when the checkbox next to Admin is marked, it designates the user 
as an Administrator)

Email - email address

You can sort in ascending or descending order by clicking on the respective column header. 
An arrow shows how rows are sorted.

To see what products are registered to each user and the Registration IDs, click the View 
Registered Products() link. The number of products registered to a user is displayed in 
parenthesis, ().

If a user has not registered a product, the Name will appear as New User, Role will appear 
as designated, and the user’s Email address will be present, but the View Registered 
Products() link will not be present.
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Adding and Removing Users

Adding Users

By adding a user to an account, the new user will be able to register a seat of software and 
have download access to any of the products within the account.

To add users, perform the following steps:

1. Click the Add New User link.

The action area for adding a new user appears.

2. Enter the user’s email address.

3. If you want the user to have administrator privileges, select Admin - Designate user 
as administrator.

4. If you want to add additional users, click the Add Another User’s Email link.

A text box for the entry of an additional new user will appear each time the link is 
selected.

5. Click Submit.

Collapsing the Add New User action area will remove the area and cancel the operation.

Removing Users

To remove users, click the Remove trash can icon displayed next to the user’s email 
address.

Modifying User Roles
To make a user an administrator, select Admin in the Role column in the View By Users 
section.

To remove administrator privileges from a user, deselect Admin in the Role column in the 
View By Users section.
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Chapter 5

Installation

This chapter describes how to install ISE™ Design Suite 10.1, as well as ModelSim Xilinx 
Edition 6.3c. It includes the following sections:

• “Installing ISE Design Suite 10.1 - Overview for All Platforms”

• “Platform Specific Instructions”

• “Installation Flow”

• “Installing Standalone Programming Tools (Lab Environment)”

• “Network Installations”

• “Accessing ISE Design Suite 10.1 Documentation”

• “Obtaining Software Updates”

• “Uninstalling ISE Design Suite 10.1”

• “Installing ModelSim Xilinx Edition 6.3c Software (MS Windows Only) - Optional”

Installing ISE Design Suite 10.1 - Overview for All Platforms
This section explains the installation process for all platforms for ISE Design Suite 10.1. 
Installation for each platform should be preceded by these steps:

1. Ensure that you have appropriate privileges on the system the software will be 
installed on. Some components, such as programming cable device drivers, require 
administrator-level permissions.

2. Close all programs before you begin installation.

3. Get the Registration ID number available from the Product Registration and 
Download site. See Chapter 4, “Using the Xilinx Product Registration and Download 
Site” for more information about obtaining a registration ID.

4. Ensure that your system meets the requirements described in Chapter 3, “Operating 
System and Architecture Support.”

5. Check Chapter 2, “Known Issues for ISE Design Suite Products” for any installation 
issues that pertain to your system or configuration.

After installation, if it has not already been done by the installer, manually set your XILINX 
Environment Variable before using the ISE Design Suite 10.1 software. See “Platform 
Specific Instructions” for more information

Platform Specific Instructions
This section explains the platform-specific details of the ISE Design Suite 10.1 installation. 
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MS Windows 
This section describes how to start the installation for MS Windows.

To Start Installation 

The method of starting the installation depends on how you have obtained the installation 
program. See the previous chapter for details on your options.

a. If you have downloaded either the WebInstall Client, or have used the “Download 
Files Individually” option for a particular product, decompress that file and run 
the setup.exe program contained therein.

b. If you have ordered and received an ISE Design Suite 10.1 DVD, load the DVD. If 
you have the auto-run feature of your DVD drive enabled, the setup program 
should start automatically. If it does not, browse to the DVD in Windows Explorer 
and run the setup.exe found at the root of the disc.

Linux
This section describes how to start the installation and set the environment variables for 
Linux.

To Start Installation 

The method of starting the installation depends on how you have obtained the installation 
program. See the previous chapter for details on your options.

a. If you have downloaded either the WebInstall Client, or have used the “Download 
Files Individually” option for a particular product, decompress that file and run 
the setup program contained therein.

b. If you have ordered and received an ISE Design Suite 10.1 DVD, load the DVD. 
Click the setup file in your file manager or browse to the root of your DVD drive 
and type ./setup. 

To Set Environment Variables

At the completion of the installation process, the installation program creates an 
environment variables file for you. Go to your XILINX installation directory and type 
source settings32.(c)sh or source settings64.(c)sh appropriate to your 
shell.

To set your environment variables manually or from within your setup script, it is 
recommended that you copy the settings from the appropriate file for your Operating 
System, as listed above. Xilinx environment variables settings are specific to each 
Operating System platform.

Installation Flow
The following section describes the screens that you will encounter during the installation 
process.

Before you begin, you will need to obtain a Registration ID number. See Chapter 4, “Using 
the Xilinx Product Registration and Download Site” for details about product registration 
and account administration.
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Note: For each of the following installation steps, you can click on the text of any item that has a 
checkbox next to it to obtain more information, which is displayed in the “Description of Highlighted 
Item Above” area near the bottom of the screen.

Welcome
The following figure shows the welcome screen:
X-Ref Target - Figure 5-1

Figure 5-1: ISE Design Suite 10.1 Installation - Welcome Screen
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Registration
Once you have obtained a Registration ID, enter it into the box provided as shown in the 
figure below.

Note: It is suggested that you use the copy and paste functionality of your system’s operating 
system to copy the Registration ID from your web browser into the box. If you manually type it in, be 
sure to verify that you enter all characters and numbers correctly - do not confuse the number “1” for 
the character “I”, etc.

X-Ref Target - Figure 5-2

Figure 5-2: ISE Design Suite 10.1 Installation - Registration Screen
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Selecting Xilinx Products
The following figure shows the screen that allows you to select the Xilinx Products you 
wish to install. (Only the products that you are entitled to install will be displayed.)

Accept Software Licenses
The following figures shows the two Accept Software License Agreement Screens you will 
have to click through. To proceed, click the I accept the terms of this software 
agreement checkbox and click Next on each screen.

Note: The order that the two screens are presented may not match that of the screenshots below.

X-Ref Target - Figure 5-3

Figure 5-3: ISE Design Suite 10.1 Installation - Select Xilinx Products Screen
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X-Ref Target - Figure 5-4

Figure 5-4: ISE Design Suite 10.1 Installation - First Accept Software License 
Screen

X-Ref Target - Figure 5-5

Figure 5-5: ISE Design Suite 10.1 Installation - Second Accept Software License 
Screen
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Select Destination Directory
In the Select Destination Directory screen, select the directory where you want the software 
installed and enter a name for the Program Folders list. By default, the directory is set to 
C:\Xilinx\10.1 and the Program Folders Name is listed as Xilinx ISE Design Suite 10.1.

The following figure shows the Select Destination Directory Screen:
X-Ref Target - Figure 5-6

Figure 5-6: ISE Design Suite 10.1 Installation - Select Destination Directory Screen
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Select Installation Options
There are three Select Installation Options screens which allow you to select Xilinx 
modules and devices, set environment variables, and choose additional install options.

Selecting Xilinx Modules and Devices

The following figure shows the screen from the Installation Software that allows you to 
select Xilinx products, modules, and Device Families you wish to install: 

Set Environment Variables

The installer provides an option to have the environment variables required by each Xilinx 
Design Suite product, if any, set automatically to appropriate values.

X-Ref Target - Figure 5-7

Figure 5-7: ISE Design Suite 10.1 Installation - Xilinx Modules and Devices
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The following figure shows the Select Installation option screen for setting environment 
variables:
X-Ref Target - Figure 5-8

Figure 5-8: ISE Design Suite 10.1 Installation - Select Environment Variables 
Screen
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Selecting Additional Options

Additional options can be selected from this screen. The following figure shows an 
example of how this screen will look:

X-Ref Target - Figure 5-9

Figure 5-9: ISE Design Suite 10.1 Installation - Select Installation Options Screen
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Begin Installation
The Begin Installation Screen gives you a summary of the tools, products, and options to be 
installed. If you want to change anything, select the Back button and make desired 
changes. To begin the installation, click Install. The following figure shows the Begin 
Installation screen:

Installing Standalone Programming Tools
(Lab Environment)

ISE 10.1 allows you to install a subset of the software just for programming all Xilinx 

devices and formatting programming files. This option allows users to set up a PC in a 
bench-top or "lab" environment for programming devices without having to install the full 
version of the software. 

To install:

1. In the Enter Registration ID screen, leave the Registration ID field blank and click Next

2. In the Select Products to Install screen, select Standalone Programming Tools and 
continue the installation process.

X-Ref Target - Figure 5-10

Figure 5-10: ISE Design Suite 10.1 Installation - Begin Installation Screen
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Network Installations
Installing software to a network location provides a way for client machines to access the 
software by pointing to it on the network drive. To run the software on the network, the 
client machines must be set up correctly to ensure that the environment variables, registry, 
and program groups all point to the network. The following sections describe the 
procedure for network setups.

UNIX Clients
Each software user must source the settings32.(c)sh or settings64.(c)sh 
(whichever is appropriate for your OS) from the $XILINX area where the software is 
installed. This points the Xilinx environment variable, path and LD_LIBRARY_PATH to 
the installed location.

3. To run the software applications from a remotely installed location, you must also run 
an X Windows display manager, and you must include a DISPLAY environment 
variable. Define DISPLAY as the name of your display. DISPLAY is typically unix:0.0. 
For example, the following syntax allows you to run the software on the host named 
bigben and to display the graphics on the local monitor of the machine called 
mynode:

setenv DISPLAY mynode:0.0
xhost = bigbenPC Clients

MS Windows Clients
1. Install the ISE software tools to a PC network server. Make sure that your users know 

the location of the software tools and have access to the installation directory, and that 
they have Administrator privileges for the following steps.

2. From the local client machine, browse to the following directory: 
network_install_location/bin/nt and run the program setXenv.bat.

Running this program sets up the environment and registry settings needed to run the 
Xilinx tools from the remote location. 

3. From the client machine, launch the ISE tolls via the Program Group or Desktop 
shortcuts, or by running the applications on the network drive.

Installing to a Mounted Network Drive
When installing to a mounted network drive without a subdirectory for Xilinx software. 
Xilinx software is designed to be installed in a directory under ROOT (typically C: \Xilinx). 
The installer presents this option normally when installing to a local driver, but when 
installing to a mounted network drive, a subdirectory might not be defined and it appears 
to the Installer as if it is installing to a ROOT directory.

To work around this issue, define your target installation directory as "\Xilinx" under the 
network mount point (For example: "N:\Xilinx").

Accessing ISE Design Suite 10.1 Documentation
Documentation for the products that are part of ISE Design Suite 10.1 can be found at 
http://www.xilinx.com/support/software_manuals.htm.
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Obtaining Software Updates
The following sections describe the ways to obtain software updates through XilinxUpdate 
and the Download Center.

XilinxUpdate
The XilinxUpdate tool is the preferred method of obtaining software updates. It provides 
the following features: 

• Compares the latest version of software updates available on 
http://www.xilinx.com/support with what you have installed, and notifies you if a 
newer version is available. 

• Downloads and installs the update in one step. 

• Downloads only the files necessary to update your installation. 

By default, XilinxUpdate automatically runs at the conclusion of the ISE Design Suite 10.1 
installation process. In addition, it can run after installation in any of the following ways: 

• Automatic periodic checks at Project Navigator startup time. 

• Help > XilinxUpdate... from Project Navigator. 

• Start > Xilinx ISE Design Suite 10.1 > ISE > Accessories > XilinxUpdate 

Note: If you unchecked the option of running XilinxUpdate during the initial software installation, it is 
strongly recommended that you run it as soon as is practical, in order to ensure that you have the 
latest updates and enhancements.

The following figure displays the XilinxUpdate Screen:
X-Ref Target - Figure 5-11

Figure 5-11: XilinxUpdate
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The Edit > Preferences menu selection in Project Navigator allows you to control the 
frequency of the automatic checks that happen at Project Navigator startup time

XilinxUpdate Network Installations

By default, the Automatically check for software updates option at Project Navigator 
startup is enabled on the machine used to install the ISE software to the network location. 
All clients pointing to this network location have this option disabled by default. Client 
users have the option of enabling this option (Edit > Preferences > XilinxUpdate from 
Project Navigator) and also running manual checks. 

Note: To perform a software update installation, you must have write permissions for the $XILINX 
installation directory. 

Download Center
Service Packs and other software updates for all platforms are regularly made available on 
the Download Center at: http://www.xilinx.com/support/download/.

Uninstalling ISE Design Suite 10.1

MS Windows
The following sections describe the how to uninstall the products that comprise ISE Design 
Suite 10.1 on MS Windows

To uninstall any Xilinx product, select the Uninstall item from that product’s Start Menu 
folder. For instance, to uninstall ISE, select Start > Programs > Xilinx Design Suite 10.1 
> ISE > Uninstall Xilinx ISE.

Alternatively, you can use the appropriate uninstall entry in the Add or Remove Programs 
dialog, accessed via the Windows Control Panel. Possible entries include:

• Xilinx ChipScope Pro 10.1

• Xilinx DSP Tools (System Generator, AccelDSP) 10.1

• Xilinx EDK 10.1

• Xilinx ISE 10.1

• Xilinx PlanAhead 10.1

Depending on what you have installed, some ancillary applications might need to also be 
uninstalled, e.g.

• WinPCap 4.0 (optional component of DSP Tools)

Linux 
To uninstall a Xilinx Design Suite 10.1 product, you need to remove the appropriate 
product directory that is found in the Design Suite root directory.

Before uninstalling, be sure you have moved any project files you want to keep outside 
your Xilinx installation directory structure, or it will be deleted.
44 www.xilinx.com ISE Design Suite 10.1 Release Notes
10.1

http://www.xilinx.com/xlnx/xil_sw_updates_home.jsp


Installing ModelSim Xilinx Edition 6.3c Software (MS Windows Only) - Optional
R

Installing ModelSim Xilinx Edition 6.3c Software 
(MS Windows Only) - Optional

If you have already purchased ModelSim Xilinx Edition (MXE) 6.3c, you will receive a 
license file after registering the MXE software after installation. For complete product and 
purchasing information for MXE, contact your local Xilinx representative or visit the 
following Xilinx Website:

http://www.xilinx.com/ise/optional_prod/mxe.htmI

To install MXE software, perform the following steps:

1. Insert the ModelSim Xilinx Edition CD. 

2. If the DVD does not auto run, select Start > Run > D:\setup.exe.

3. Follow the instructions to complete the installation.

4. Follow the instructions provided to complete a license request. A license file will be 
e-mailed to you.

5. Put the license in a location pointed to by the LM_LICENSE_FILE variable as follows:

set LM_LICENSE_FILE=<path_to_license>\license.dat

You can also cut and paste the contents into your existing license.dat file.

Windows Vista
MXE 6.3c is not officially supported on Window Vista Machines by Mentor. There is 
however, a workaround that can be used on Vista machines which might allow you to run 
MXE 6.3c using either a USB dongle or Ethernet ID license. Please search for solution 
record with keyword “MXE 6.3c and VISTA” for more information. Parallel port dongle 
licenses are not supported on Windows Vista machines.
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Chapter 6

Product-Specific Installation, 
Registration, and Usage Notes

This chapter consists of product-specific sections, each of which specifies details that must 
be considered when installing and using each of the products contained in ISE™ Design 
Suite 10.1. 

This chapter contains the following sections:

• “Integrated Software Environment (ISE)”

• “CORE Generator Intellectual Property”

• “ChipScope Pro and ChipScope Pro Serial I/O Toolkit”

• “Embedded Development ToolKit (EDK)”

• “DSP Tools (AccelDSP and System Generator) and PlanAhead/PlanAhead Lite”

Integrated Software Environment (ISE)
This section contains the following:

• “System Requirements”

• “Equipment and Permissions”

• “ISE Software Documentation”

System Requirements
This section provides information on supported operating systems, Web browser, cable 
installation, and system memory requirements.

Cable Installation Requirements

Platform Cable USB and Parallel Cable IV are high-performance cables that enable Xilinx 
design tools to program and configure target hardware.

To install Platform Cable USB, a system must have at least a USB 1.1 port. (For maximum 
performance, Xilinx recommends using Platform Cable USB with a USB 2.0 port.) To install 
Parallel Cable IV, a system must have a parallel port connector and support parallel port 
communication.
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Cables are officially supported on the 32-bit and 64-bit versions of the following operating 
systems: Windows XP Professional, Windows Vista Business, Redhat Linux Enterprise, 
and SUSE Linux Enterprise 10. Additional platform specific notes are as follows:

• All Linux: Root privileges are required to install cable drivers on Linux 

• SUSE Linux Enterprise 10: The fxload software package is required to ensure correct 
Platform Cable USB operation. The fxload package is not automatically installed on 
SUSE Linux Enterprise 10 distributions, and must be installed by the user or System 
Administrator. 

• Linux LibUSB support: Preliminary support for Platform Cable USB based upon the 
LibUSB package is now available from the Xilinx website. See Answer Record # 25249 
for details. 

For additional information regarding Xilinx cables, refer to the following documents:

• USB Cable Installation Guide (UG344)

• Platform Cable USB Data Sheet (DS300)

• Parallel Cable IV Data Sheet (DS097)

System Memory Recommendations

This section gives the RAM and swap space needed to run ISE Design Suite 10.1 on your 
system.

While the following table lists the system recommendations for typical designs, the unique 
characteristics of each design affect the system resources required. Design complexity and 
constraints affect whether the design can be implemented using more or less memory. 
Each designer must monitor the system resources and adjust the systems resources, if 
necessary. For more information on memory recommendations, see: 
http://www.xilinx.com/ise/products/memory.htm. 

Operating Systems and Available Memory

The MS Windows and Linux® operating system (OS) architectures have limitations on the 
maximum memory available to a Xilinx program. Users targeting the largest devices and 
most complex designs may encounter this limitation. ISE Design Suite 10.1 has optimized 
memory and enabled software support for applications to increase RAM memory 
available to Xilinx software. 

Windows XP Professional 32-bit

Xilinx applications are enabled to take advantage of the memory increase feature on 
Windows 32-bit. You must then modify Windows setting to get access to this larger 
memory. 

The standard Windows OS architecture limits the maximum memory available to a Xilinx 
process to 2 Gigabyte. In Windows XP Professional, Microsoft created an option to support 
the ability of an application to address 3 Gigabyte of RAM. Xilinx ISE applications have 
built-in support for this option. To take advantage of this capability, you must also modify 
your Windows XP OS to enable this feature, which requires that you modify your boot.ini 
file by adding a “/3GB” entry to the end of the “startup” line.

Before enabling 3GB support for Xilinx applications, please read Microsoft Knowledge 
Base Article #328269 at http://support.microsoft.com/?kbid=328269. If you upgrade your 
computer to Windows XP Service Pack 1 (SP1) and you are using the /3GB switch, 
48 www.xilinx.com ISE Design Suite 10.1 Release Notes
10.1

http://www.xilinx.com/ise/products/memory.htm
http://www.xilinx.com/ise/products/memory.htm
http://support.microsoft.com/?kbid=328269


Integrated Software Environment (ISE)
R

Windows may not restart without a patch from Microsoft. Please see (Xilinx Answer 17905) 
for more information. 

Additionally, before making this change, please read: 

• Microsoft Bulletin Q17193 http://support.microsoft.com/default.aspx?scid=kb;en-
us;Q171793, which contains information on “Application Use of 4GT RAM Tuning”.

• Microsoft Bulletin Q289022 http://support.microsoft.com/default.aspx?scid=kb;en-
us;q289022, contains instructions for editing your “boot.ini” file. 

Linux

ISE Design Suite 10.1 supports both Linux 32-bit and Linux 64-bit, the latter allows greater 
memory allocation. Xilinx has documented Linux kernel modifications that allow a Xilinx 
application to address over 3 GB of memory. 

For 32-bit Red Hat Enterprise Linux systems, the operating system can use the hugemem 
kernel to allocate 4GB to each process. More information can be found on the Red Hat 
support site: http://www.redhat.com/docs/manuals/enterprise/

ISE supports the 64-bit version of Red Hat Enterprise Linux, which allows greater memory 
allocation out of the box.

Equipment and Permissions
The following table lists related equipment, permissions, and network connections.

Table 6-1: Equipment and Permissions Requirements

Note: X Servers/ Remote Desktop Servers such as Exceed, ReflectionX, and XWin32 are not 
supported.

Network Time Synchronization

When design files are located on a network machine, other than the machine with the 
installed software, the clock settings of both machines must be set the same. These times 
must be synchronized on a regular basis for continued proper functioning of the software.

Item Requirement

Directory permissions Write permissions must exist for all directories containing 
design files to be edited. 

Monitor 16-bit color VGA with a minimum recommended resolution 
of 1024 by 768 pixels. 

Drive You must have a DVD-ROM for ISE Design Suite (if you 
have received a DVD, rather than downloading from the 
web), and CD-ROM for MXE on your system.

Ports To program devices, you must have an available parallel, or 
USB port appropriate for your Xilinx programming cable. 
Specifications for ports are listed in the documentation for 
your cable.

Note: Installation of the cable driver software requires Windows 
XP Pro SP1 (or later), or Windows Vista Business. If you are not 
using one of these operating systems, the cables may not work 
properly.
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ISE Software Documentation

Context-Sensitive Help

Context-sensitive online Help is available for most Xilinx ISE programs that are available 
with a graphical user interface (GUI). From Project Navigator, select Help > Help Topics to 
access the online Help. 

Software Manuals

Detailed ISE Software Manuals are included as part of the software installation. After you 
install the software, you can select the Help > Software Manuals command in Project 
Navigator to access the Software Manuals collection.

Note: If you do not already have Adobe Acrobat Reader installed, you must do so to view 
the installed documentation.

Software Manuals Online

ISE Software Manuals are also available on the Xilinx Website. Refer to the ISE Design Suite 
10.1 documentation collection at 
http://www.xilinx.com/support/software_manuals.htm.

CORE Generator Intellectual Property
This section contains the following information:

“Installation Instructions”

“Release Notes”

Installation Instructions
The first Intellectual Property (IP) Update for ISE 10.1 CORE Generator™ software, 
IP_10.1.0, is integrated into the initial ISE Design Suite 10.1 software release and is 
automatically installed with it.

Subsequent ISE 10.1-compatible updates are cumulative and will be advertised on the 
Xilinx Intellectual Property Center, http://www.xilinx.com/ipcenter, as they become 
available. These future updates will be downloadable from the Xilinx Download Center, 
and will also usually require installation of specific ISE Service Packs. 

Some IP cores might also require license purchase or installation of a license key to activate 
full access. IP-specific requirements along these lines are documented on the product page 
for each core in the Xilinx Intellectual Property Center.

Release Notes
General information about this release can be found at: 

http://www.xilinx.com/ipcenter/coregen/updates_101_ip0.htm,

and a complete listing of the IP included in this release can be found at:

http://www.xilinx.com/ipcenter/coregen/101_0_datasheets.htm 
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For IP-specific release note information related to IP Core Updates shipped in the ISE 
Design Suite 10.1 software release as well as updates shipped in earlier ISE releases, please 
refer to the IP Release Notes Guide:

http://www.xilinx.com/support/documentation/user_guides/xtp025.pdf

The ISE 10.1 CORE Generator initial IP release includes new and updated IP in the 
following categories: 

• Audio, Video, & Image Processing (Color Space Converters)

• Automotive (CAN, MOST, FlexRay)

• Communications and Networking (Error Correction, Ethernet, SPI-4.2, Wireless)

• Debug & Verification (ChipScope Pro)

• Digital Signal Processing (Filters, Transforms, Waveform Synthesis)

• FPGA Features & Design (Aurora and RocketIO™)

• Memories and Storage (Memory Interface (MIG), Block Memory and Distributed Mem-
ory Generators)

• Standard Bus Interfaces (PCI Express, PCI, RapidIO)

ChipScope Pro and ChipScope Pro Serial I/O Toolkit
This section contains the following:

“System Requirements”

“Architecture Support”

“Registering and Enabling ChipScope Pro Serial I/O Toolkit”

System Requirements
This section provides information on cable installation and system memory requirements.

Cable Installation Requirements

For Linux, cable drivers require root privileges to install. To install platform cable USB for 
USB 2.0 port, you must have WinXP SP2. The platform cable USB is a high-performance 
download cable that attaches to user hardware for use with the ChipScope Pro Analyzer 
tool for device programming, configuring, and debugging. 

System Memory Recommendations

The ChipScope Pro Analyzer requires 1024 mega bytes of system memory. The ChipScope 
Pro Core Inserter tool has the same requirements as ISE. For more information on ISE 
memory recommendations, see: http://www.xilinx.com/ise/products/memory.htm. 
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Architecture Support
The Agilent Trace Core 2 (ATC2) that is included in the ChipScope Pro 10.1 product 
supports the following architecture families:

• Virtex™/-II/-II Pro/-II Pro X/-4/-5

• QPro Virtex™/-II Pro Hi-Rel

• QPro Virtex™/-II Rad-Hard 

• Spartan™-3/-3E/-3A/-3AN/-3ADSP

• Automotive Spartan™-3/-3E

Registering and Enabling ChipScope Pro Serial I/O Toolkit
The registration and download flow for the ChipScope Pro Serial I/O Toolkit add-on 
feature is slightly different than the ChipScope Pro process:

1. If you are entitled to the ChipScope Pro Serial I/O Toolkit 10.1 product, on the Select 
Products screen, select the ChipScope Pro Serial I/O Toolkit 10.1 product from the list 
of Entitled Products section. If you are not entitled to the ChipScope Pro Serial I/O 
Toolkit 10.1 product, you can select the ChipScope Pro with ChipScope Pro Serial I/O 
Toolkit License Key from the Evaluation/Free Products section to get a free 60-day 
license to both ChipScope Pro and the ChipScope Pro Serial I/O Toolkit add-on 
features.

2. Click the Next button.

3. On the Download page, note the Registration ID that was generated.

4. If ChipScope Pro has not already been installed, follow the instructions in the previous 
section. If it has been installed, go to the next session.

Note: There is no installer required to download and install the ChipScope Pro Serial I/O Toolkit 
add-on feature. The program and data files that make up the ChipScope Pro Serial I/O Toolkit 
add-on feature are installed at the same time that the ChipScope Pro product is installed.

5. Enable the ChipScope Pro Serial I/O Toolkit by entering the Registration ID noted in 
Step 3 above into the ChipScope Pro Update Software Product Configuration tool:

On Windows: Start > All Programs > Xilinx ISE Design Suite 10.1 > ChipScope Pro 
> Accessories > Update Software Product Configuration

Note: Do not use the Update Software Product Configuration utility that is located under other 
ISE Design Suite 10.1 product folders (such as ISE) as this will not correctly enable the 
ChipScope Pro Serial I/O Toolkit add-on feature.

On 32-bit Linux: $CHIPSCOPE/bin/lin/setup -autoupgrade

On 64-bit Linux: $CHIPSCOPE/bin/lin64/setup -autoupgrade

The ChipScope Pro Serial I/O Toolkit add-on feature is now ready for use.
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Embedded Development ToolKit (EDK)
This section contains the following:

“EDK Contents”

“EDK Requirements”

“Xilinx EDK Development Boards”

“Notes on Installing EDK on MS Windows”

“Notes on Installing EDK on Linux”

“EDK Installation Directory Structure”

“EDK Documentation”

“EDK Supported Software Versions”

“Other EDK Information”

“About Example User Constraint Files”

EDK Contents
The components of EDK are:

• Hardware IP for the Xilinx embedded processors and their peripherals

• Drivers, Libraries, and a MicroKernel for Embedded Software Development

• Xilinx Platform Studio (XPS) tools

• Software Development Kit (SDK), Eclipse-based IDE

• GNU Compiler and Debugger for C development for MicroBlaze™ and PowerPC® 
(405 and 440) processors

• Documentation

• Sample projects

Except for these release notes, EDK does not include printed documentation material. 
Refer to the “EDK Documentation” section for a list of documents available. Also not 
included but available as separate products are FPGA development boards and the Xilinx 
FPGA implementation tools package, ISE™ 10.1. Refer to the “EDK Requirements” and the 
“Xilinx EDK Development Boards” sections for further details.

EDK Requirements
• Xilinx ISE 10.1

The Xilinx FPGA design implementation tools, ISE 10.1 (WebPACK or Foundation), 
are required to implement embedded designs generated with the XPS tools. Several 
EDK tools use functionality delivered with tools contained in ISE 10.1.

Note: Updates to ISE 10.1 including service packs are available at: 
http://www.xilinx.com/support/mysupport.htm.

• Development Board

To test your MicroBlaze processor or PowerPC processor system on an FPGA, you 
must have access to a development board that contains a Xilinx FPGA and several 
other components as well as standard download, configuration, and debug 
connectors.
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Operating system specific requirements:

• Linux–Bash shell

Xilinx EDK Development Boards
Development boards are available from Xilinx and Xilinx partners. Xilinx boards that are 
currently available include:

• Xilinx ML300 (supported in an upcoming Service Pack)

• Xilinx ML310

• Xilinx ML401

• Xilinx ML402

• Xilinx ML403

• Xilinx ML405 

• Xilinx ML410 

• Xilinx ML501 

• Xilinx ML505

• Xilinx ML506

• Xilinx ML507 support when FXT becomes full access.

• Xilinx Spartan-3 Starter Kit

• Xilinx Spartan-3E Starter Board

• Xilinx Spartan-3E 1600E MicroBlaze Development Board

• Xilinx Spartan-3A Starter Kit

• Xilinx Spartan-3AN Starter Kit

Contact your local Avnet, Memec, Nu Horizons or other authorized distributor to obtain 
any partner board.

Notes on Installing EDK on MS Windows
This section summarizes the EDK installation process on the Windows platform.

EDK Windows Environment Variables and Registry Settings

The EDK installer creates or modifies the following variables on your machine. These 
variables are added to the system settings. 

♦ XILINX_EDK
Sets the value of this variable to the EDK installation directory.

♦ PATH
Prefixes the PATH environment variable with 
%XILINX_EDK%\bin\nt;%XILINX_EDK%\lib\nt

EDK tools require the Cygwin tools distributed by Red Hat. A copy of these tools is 
distributed with the EDK installation. When you run XPS, the SDK IDE, or Xilinx Shell, 
your registry is checked for the entry: 
My Computer\HKEY_CURRENT_USER\SOFTWARE\Cygnus Solutions\Cygwin. 
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If a compatible version of Cygwin is found pre-installed on your machine, the EDK tools 
use it. Otherwise, the registry is set up to point to the Cygwin tools distributed in the EDK 
installation area. 

Note: When you install EDK, Cygwin installation files are copied to your system. Whether or not the 
copied files are installed depends on the state of existing Cygwin installations on the machine. If you 
already have Cygwin installed, and if the existing Cygwin installation meets requirements, EDK does 
not install Cygwin (and the existing Cygwin installation is used). Otherwise, EDK installs Cygwin from 
the installation area. For more information, refer to the “EDK Shell” Chapter in the Embedded System 
Tools Reference Manual, available at http://www.xilinx.com/ise/embedded/edk_docs.htm.

Notes on Installing EDK on Linux
This section summarizes the EDK installation process on the Linux platform.

Linux EDK Environment Variables

EDK installer creates settings.csh and settings.sh files in the EDK installation 
directory. These files set up the environment for using the EDK tools. 

♦ $XILINX_EDK
Sets the value of this variable to the installation direction.

♦ $PATH
Prefixes the $PATH environment variable with:

- $XILINX_EDK/gnu/microblaze/lin/bin

- $XILINX_EDK/gnu/powerpc-eabi/lin/bin/

♦ $LD_LIBRARY_PATH
Prefixes the $LD_LIBRARY environment variable with 
$XILINX_EDK/bin/lin.

Note: While executing the script, make sure that the $XILINX_EDK/bin/lin appears before 
$XILINX/bin/lin in the $LD_LIBRARY_PATH variable.

EDK Installation Directory Structure
The installed image of EDK is organized into the following directories, where 
<edk_install_dir> is the location of the root of the EDK image.

Table  7:  EDK Directories

Directory Description

$XILINX_EDK/ This directory is the EDK installation root directory.

bin/ This directory contains the embedded system tools 
application executables.

The EDK installer has already set up your environment 
variables to include the executables of the embedded system 
tools that reside in the bin directory.

board/ This directory contains board description files.

The boards directory provides board files for Xilinx boards, 
which are required by the Base System Builder for creating 
embedded systems. Board files for partner boards must be 
obtained directly from the partners.
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EDK Documentation
This subsection describes how to locate the EDK documentation in the software and on 
web and provides an overview of the available EDK documents.

Locating EDK Documentation

Use index.htm to Find EDK Documentation

A comprehensive set of links to EDK-related documents are provided in your EDK 
installation directory at $XILINX_EDK/doc/usenglish/index.htm. 

EDK Documentation on the Web

You can find most EDK documentation on the Xilinx web. Look under the heading 
“Documentation” at:

http://www.xilinx.com/ise/embedded_design_prod/platform_studio.htm. 

In addition to providing links to the documents listed below, this web page provides links 
to application notes, reference designs, design examples, and a product brief.

cygwin/ This directory contains the Cygwin portability layer 
(available only on Windows platforms).

doc/ This directory contains the EDK documentation.

EDK-related documentation resides in the /doc directory. 
Refer to “EDK Documentation”.

data/ This directory has default option files required by ISE tools.

eclipse/ This directory contains files for the XPS Software 
Development Kit (Eclipse-based). 

EDKexamples/ This directory contains sample projects.

gnu/ This directory contains the EST GNU Tools.

hw/ This directory contains MicroBlaze processor and peripheral 
hardware components.

The hw/ directory contains the HDL sources for the 
hardware IP.

java/ This directory contains Java Runtime 1.4.2 required by SDK.

sw/ This directory contains drivers, BSPs, and software services.

The sw/ directory contains the drivers required by the IP 
installed in the hw/ directory, the board support packages. It 
also contains the source for various modules of the Xilinx 
MicroKernel, such as the Networking library and the file 
system. Software libraries and initialization files are also 
contained in the sw/ directory.

third_party/ This directory contains the IBM Instruction Set Simulator.

Table  7:  EDK Directories (Cont’d)

Directory Description
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EDK Documentation Set

The EDK documentation set includes:

• This chapter of the ISE Design Suite 10.1 Release Notes

• Tools documentation and processor IP reference guides

• Processor reference guides

• Online help for XPS and SDK.

Note: The Processor IP Reference Guide (Xilinx Processor IP Library) and the Driver Reference 
Guide are available only from the $XILINX_EDK/doc/usenglish folder. The SDK Online 
Help is published only in the SDK GUI.

User Guides

EDK Profiling User Guide

The EDK Profiling User Guide provides information about profiling software running on 
embedded systems built with EDK. Profiling is software-intrusive and is based on the 
GNU gprof tool. This document details how profiling works, how to set up the hardware 
and software systems to perform profiling, and how to view the resulting profile data.

EDK Concepts, Tools, and Techniques

The EDK Concepts, Tools, and Techniques book gives you a hands-on tour of the product. 
Each section describes an aspect of embedded design creation and provides an 
opportunity for you to take a “Test Drive” using XPS tools.

Tools and IP References

EDK provides reference guides that cover the basic usage of the various tools that are 
included.

Tools Reference Manuals

• Embedded System Tools Reference Manual

This manual provides detailed information about all the tools available in the EDK 
suite, including XPS, Xilinx Microprocessor Debugger (XMD), Libgen, Simgen, 
Platgen, GNU compiler (GCC) and debuggers. 

• IBM PowerPC ISS Reference Guide

EDK provides a third party tool for simulation of PowerPC™ (405 and 440) processor 
systems. The documentation for this is included in a separate guide, the IBM PowerPC 
ISS Reference Guide.

Libraries and Drivers Reference Documents

• OS and Libraries Document Collection

This document set details the information about the libraries which are shipped as a 
part of EDK. It details the API that is required for customers who intend to use the 
provided libraries. The document collection includes a Standalone Board Support 
Package (BSP) document, the Xilinx Xilkernel document, the FAT File System (FATFS) 
and Memory File System (MFS), as well as the Flash library, and the open source light 
weight IP (lwIP) library. 
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• Driver Reference Guide

This guide provides detailed API and other information for each driver provided in 
the EDK installation. The guide is presented as a web page with links to a set of web-
based documentation.

IP Reference Guides

• Processor IP Reference Guide (Xilinx Processor IP Library)

Processor IP is an important part of the EDK distribution. Its documentation consists 
of individual data sheets with important information about parameters and port 
connections for each IP. This information is required by hardware designers for 
designing their system. For systems created through the Base System Builder, some of 
the basic connections are done by a wizard, but for advanced connections and other 
peripherals, refer to the Processor IP Reference Guide. 

This guide also provides easy access to the core data-sheet, modification history, 
architecture support information and ready access to purchase information for pay 
cores. It is presented as a web page with links to a set of web-based documentation. 

• PLB46 Interface Simplifications (SP026 v1.0)

Describes the simplifications to the PLB v4.6 specification in the Xilinx implementation 
of the bus. The document also provides guidance for designing masters and slaves that 
connect to the bus.

• PLB v3.4 and OPB to PLB v4.6 System and Core Migration User Guide (UB443 v1.0)

This user guide provides an overview of the Xilinx implementation of the PLB v4.6 
bus. It then explains how both MicroBlaze and PowerPC (405 and 440) systems can be 
migrated to use the new interconnect. Instructions are also provided on how to 
migrate user-designed slave and master peripheral cores.

Processor References

PowerPC Processors

• PowerPC® Processor Reference Guide

This document is intended to serve as a stand-alone reference for application and 
system programmers of the PowerPC 405D5 processor. This document also contains 
the API and the instruction set architecture of PowerPC405.

• PowerPC 405 Processor Block Reference Guide

This manual details the Xilinx implementation of the PowerPC® 405 processor. It is 
targeted to hardware and system designers.

• PowerPC 440 Processor Block Reference Guide

This manual details the Xilinx implementation of the PowerPC® 440 processor. It is 
targeted to hardware and system designers.

• PowerPC 405 Processor ISA Extensions for Virtex-4 FPGAs

This is addendum documentation listing the new instructions provided for the Fabric 
Co-processor Module interface in Virtex-4 FX FPGAs.
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MicroBlaze Processor

• MicroBlaze Processor Reference Guide

This document is intended to serve as a stand-alone reference for application and 
system programmers of the MicroBlaze processor. The detailed ISA and the ABI for the 
MicroBlaze processor are also described in this document. 

XPS and SDK Online Help

Online help is available from the XPS and SDK GUIs.

EDK Supported Software Versions
The following table provides the software version which are included or which are 
supported in EDK 10.1:

Table 6-1: EDK Supported Software Versions

Software Vendor Release Version Xilinx Release Number

ISE Version n/a 10.1

lwIP Library n/a v 3.00.a

Standalone Board Support 
Package

n/a v2.00.a

Xilkernel n/a v4.00.a

Automatic Generation of 
Tornado 2.x (VxWorks 5.x) 
Board Support Packages

VxWorks 5.x n/a

Automatic Generation of 
Wind River VxWorks 6.1 
Board Support Packages

VxWorks 6.1 n/a

Automatic Generation of 
Wind River VxWorks 6.3 
Board Support Packages

VxWorks 6.3 n/a

Automatic Generation of 
Wind River VxWorks 6.5 
Board Support Packages

VxWorks 6.5 n/a

LibXil Flash n/a v1.00.a

Automatic Generation of 
Linux 2.4 (MontaVista 
Linux 3.1) Board Support 
Packages

(MontaVista Linux 3.1) n/a

Automatic Generation of 
Linux 2.6 Board Support 
Packages

Linux 2.6 n/a

MicroBlaze GNU Tools v 2.10.1 n/a
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Other EDK Information

Migrating Old Projects

The IP Core Version Management Wizard migrates older projects to the current version of 
XPS. It will point out changes to the cores, and in some cases, help you upgrade to newer 
revisions of cores currently in your project. Migration instructions can also be found in the 
Embedded Systems Tools Reference Manual. 

About Example User Constraint Files
There are some IPs, such as the PLB RapidIO LVDS and the OPB PCI, which need certain 
example user constraints files (UCFs) to be available in your project area. When such IPs 
are used in an EDK project, tools give out the following ALERT message: 

An example UCF is available for this core and must be modified for use 
in the system. Please refer to the EDK Getting Started guide for the 
location of this file.

The UCF file for the IP can be found at:

$XILINX_EDK/hw/XilinxProcessorIPLib/pcores/peripheral_name/data/

where $XILINX_EDK is the installation area.

Third Party Tools

EDK is designed to work with some third party tools that you can obtain and set up 
separately. This subsection provides some information on these tools.

IBM CoreConnect Toolkit

EDK is designed to integrate seamlessly with the IBM® CoreConnect™ Toolkit. This toolkit 
is not included with EDK, but is required if bus functional simulation is desired.

The toolkit provides a number of features that enhance design productivity. To obtain the 
toolkit, you must have a license for the IBM CoreConnect Bus Architecture. Licensing 
CoreConnect provides access to a wealth of documentation, Bus Functional Models, 
Hardware IP, and the CoreConnect Toolkit.

GNU Tools for MicroBlaze 
and PowerPC (405 and 440) 
processors

v 2.16 n/a

GCC compiler tools for 
MicroBlaze and PowerPC 
(405 and 440) processors

GCC 4.1.1 n/a

Cygwin v 1.5.17 for Windows

v 1.5.24 or higher for Vista

n/a

Eclipse 3.1.2 10.1

Table 6-1: EDK Supported Software Versions (Cont’d)

Software Vendor Release Version Xilinx Release Number
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Xilinx provides a Web-based licensing mechanism that allows you to obtain the 
CoreConnect Toolkit from the Xilinx website. You can license CoreConnect online at 
http://www.xilinx.com/products/ipcenter/dr_pcentral_coreconnect.htm. 

Once the request is approved (typically within 24 hours), you will receive an email 
granting access to the protected web site. You can then download the toolkit.

You can also get the CoreConnect license directly from IBM.

For further documentation on the CoreConnect Bus Architecture, refer to the IBM 
CoreConnect website at http://www-
01.ibm.com/chips/techlib/techlib.nsf/products/CoreConnect_Bus_Architecture.

Setting Up the EDK Simulation Environment

For simulation of embedded designs, you must set up your simulation environment. This 
is required every time you install a new release or a service pack of EDK. For information 
about setting up simulation environments, refer to the XPS Help.

EDK tools support ModelSim PE/SE & NCSim LDV/IUS versions as supported by ISE 
10.1 tools. The verification of EDK tools and processor IP is done using:

• Modelsim SE/PE 6.3c

• NCSim IUS 6.1 or later (NCSim 6.1 is not available on Windows)

Using EDK with ChipScope Pro

EDK enables hardware designers to create processor systems rapidly using the ChipScope 
Pro CoreConnect Bus Analyzer cores and the Virtual IO (VIO) core. EDK supports the 
following ChipScope Pro cores:

• chipscope_icon

• chipscope_plbv46_iba

• chipscope_ila

• chipscope_vio

• chipscope_plb_iba

• chipscope_opb_iba

To instantiate these cores in an EDK design, you must have a valid ChipScope Pro 
Installation.

DSP Tools (AccelDSP and System Generator) and 
PlanAhead/PlanAhead Lite

The DSP Tools and PlanAhead™/PlanAhead Lite are included in the ISE Design Suite for 
10.1. For more information on each product, see the What’s New file located at:

http://toolbox.xilinx.com/docsan/xilinx10/swcol/whatsnew.htm
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Chapter 7

Technical Services and Support

This chapter describes how to contact Xilinx for Customer Support and Services, and how 
to find up-to-date information about Xilinx products. This chapter contains the following 
sections:

• “Accessing Technical Services and Support”

• “Software Customer Service”

• “Customer Education”

Accessing Technical Services and Support 
This section describes some of the features available from the Website.

Support by Product
Please visit the Xilinx Support site at http://www.xilinx.com/support, where you can find 
support information arranged by Device Family. If you would like to view the support 
page in the MySupport view, you need to login.

Design and Education Services
Visit the Design and Education Services Website at 
http://www.xilinx.com/support/gsd/index.htm for information on Xilinx® Support 
Services, Titanium Technical Service, Design Services, Education Services, and the Xilinx 
Productivity Advantage (XPA) program.

Technical Support
This section describes some of the support features available from the Website.

Download Center

Visit the Download Center at http://www.xilinx.com/support/download/index.htm to 
access the latest software Service Packs, IP Updates, and more.

Answer Records

Use our Answer Records to help troubleshoot issues or find solutions to common technical 
issues. You can search through the Answer Record database from any Xilinx.com page. 
Additionally, you can use Advanced Search at:

http://www.xilinx.com/company/advanced-search.htm 
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Software Manuals

To access the Software Manuals and Help collection on the web go to: 

http://toolbox.xilinx.com/docsan/xilinx10/books/manuals.pdf 

The software manuals available from this collection provide detailed information about 
the ISE software applications and command-line functions. The Help available from this 
collection provides procedural information for using the ISE software applications.

Note: The Libraries Guide and Constraints Guide on the Web are updated periodically with the 
latest device-specific information. Check the Software Manuals Website for the most up-to-date 
information.

WebCase

Visit WebCase at http://www.xilinx.com/support/clearexpress/websupport.htm to 
create a technical support case or to monitor the status of a case.

Contact Technical Support and Services
This section describes how to contact Xilinx for additional information and assistance.

Technical Support Hotline

Contact the Technical Support Hotline at one of the numbers listed in the following table.

Note: For the most up-to-date contact information, visit the Technical Support Web page at 
http://www.xilinx.com/support/services/contact_info.htm.

Region Language Phone* WebCase Support Hours

North America EN 1 800-255-7778 or

+1 408-879-5199

Please open a case via 
WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 7:00 - 17:00 PST

Europe, Middle

East, and Africa

EN, DE, FR 00 800-5152-5152*** 
or 

+353 1-461-5700

WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 8:00 - 17:00 
GMT

Japan JP +81 3-6744-7800 Japan WebCase:
http://japan.xilinx.com/s
upport/clearexpress/webs
upport.htm

M-F 9:00 - 17:30 JST

Korea EN +82 2-3144-0255 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 10:00 - 19:00 
KST

China CH (Mandarin), 
EN

+86 800-988-0218
(China mainland)

+86 400-880-0218
(Cell phone user)

China WebCase:
http://china.xilinx.com/s
upport/clearexpress/webs
upport.htm

M-F 9:00 - 18:00 CST
64 www.xilinx.com ISE Design Suite 10.1 Release Notes
10.1

http://toolbox.xilinx.com/docsan/xilinx10/books/manuals.pdf
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/services/contact_info.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://japan.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://china.xilinx.com/support/clearexpress/websupport.htm


Software Customer Service
R

Corporate Switchboard + 1-408-559-7778

* For the numbers listed, '+' represents the International Direct Dialing (IDD) prefix of the 
country from which you are calling. Consult your local telephone service provider for 
more information on the IDD codes for the country from which you are calling.

** Support Hours listed apply for both standard and daylight savings time. 

** 00 800-5152-5152 is a international free phone (toll free) toll free number available in the 
following countries: Austria, Belgium, Denmark, Finland, France, Germany, Ireland, 
Israel, Italy, Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, 
and the United Kingdom. When dialing from other countries, use the alternate number 
provided, which is charged at international direct-dial rates.

Education Services

To take advantage of the latest ISE software features, go to the Xilinx Website, and click 
Design and Education Services > Education Services to download e-learning modules 
and to sign up for updated ISE software training classes that help you maximize 
productivity and increase your skill set while lowering your overall development costs.

Order Management

Go to the Xilinx Website and click Online Store to visit the Xilinx Online Store or contact 
your local Xilinx distributor for products and services available through Xilinx.

Software Customer Service
Visit http://www.xilinx.com/company/sales/ww_reps.htm to find sales and distributor 
contact information for your region

Taiwan  CH 
(Mandarin), EN

+886 2-8176-1060 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

Hong Kong CH (Mandarin), 
EN

+852 3187-3855 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

Singapore CH (Mandarin), 
EN

+65 6544-8998 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

Rest of Asia CH (Mandarin), 
EN

+86 21-3318-4757 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

Region Language Phone* WebCase Support Hours
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Customer Education
This section describes the ways you can learn to use the Xilinx software tools, including 
using the software manuals and online help, taking a customer education course, or taking 
an online tutorial.

Training Classes
Xilinx offers specialized training modules and software update classes at many 
different locations. 

For more information about customer training classes and software training for Xilinx 
products, use the Xilinx Support Website at:

http://www.xilinx.com/support/education-home.htm

You can also contact a Xilinx Training Administrator at the following toll-free number: 

1-877-XLX-CLASS

International customers please contact your local sales representative or distributor for 
area-specific training programs.

User Tutorials
All tutorials on the Web can be found at:

http://www.xilinx.com/support/techsup/tutorials/index.htm

Software Manuals Online and Online Help
All manuals and Online Help on the Web can be found at:

http://toolbox.xilinx.com/docsan/xilinx10/books/manuals.pdf

E-learning
This is a system that provides in-depth technical training sessions on Xilinx® 
programmable logic products over the Web. For more information, use the following 
Website:

http://www.xilinx.com/support/training/free-courses.htm
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Appendix A

License Agreements

The following licenses govern the Xilinx use of some third-party vendor software in ISE™ 
Design Suite 10.1. Each license applies only to the named vendor’s software, and not to ISE 
Design Suite 10.1 as a whole. Your use of the ISE Design Suite 10.1 software is governed by 
the click licenses accepted during installation. 

PERL License Agreement 
XILPERL is a modified version of PERL licensed to Xilinx® and to you under the Artistic 
license. The text of the artistic license may be seen at: 
http://www.perl.com/language/misc/Artistic.html 

XILPERL is invoked implicitly by ISE release 10.1 applications when it is needed and there 
is no need for the user to invoke it directly. The only difference between XILPERL and 
unmodified PERL is that XILPERL picks up its input script file from the location specified 
in the Xilinx environment variable, and not from STDIN. 

XILPERL is not packaged in ISE release 10.1 to be used as a standalone PERL by the end 
user. The unmodified version of PERL may be obtained in source or executable form from 
http://www.perl.com. 

Scintilla and SciTE License Agreement
The ISE Design Suite 10.1 Graphical User Interface software uses the Scintilla Source Code 
Editor whose license follows: 

Copyright 1998-2003 by Neil Hodgson <neilh@scintilla.org>

All Rights Reserved 

Permission to use, copy, modify, and distribute this software and its documentation for any 
purpose and without fee is hereby granted, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this permission notice appear 
in supporting documentation. 

NEIL HODGSON DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS 
SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS, IN NO EVENT SHALL NEIL HODGSON BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 
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Regex License Agreement
ISE release 10.1 contains the Regex software from the Boost libraries licensed under the 
following terms:

Copyright (c) 1998-2000

Dr John Maddock

Permission to use, copy, modify, distribute and sell this software and its documentation for 
any purpose is hereby granted without fee, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this permission notice appear 
in supporting documentation. Dr John Maddock makes no representations about the 
suitability of this software for any purpose. It is provided “as is” without express or 
implied warranty.

Integer Traits License Agreement
ISE release 10.1 contains the Integer Traits software from the Boost libraries licensed under 
the following terms:

Copyright Jens Maurer 2000

Permission to use, copy, modify, sell, and distribute this software is hereby granted 
without fee provided that the above copyright notice appears in all copies and that both 
that copyright notice and this permission notice appear in supporting documentation, Jens 
Maurer makes no representations about the suitability of this software for any purpose. It 
is provided “as is” without express or implied warranty.

Apache Software License Agreement
ISE release 10.1 includes some software developed by the Apache Software Foundation 
(http://www.apache.org/). The Apache software is licensed under the following terms:

The Apache Software License, Version 1.1 

Copyright (c) 1999 The Apache Software Foundation. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

3. The end-user documentation included with the redistribution, if any, must include the 
following acknowledgment: 

“This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/).” Alternately, this acknowledgment may appear in the 
software itself, if and wherever such third-party acknowledgments normally appear. 

4. The names “Sources” and “Apache Software Foundation” must not be used to endorse 
or promote products derived from this software without prior written permission. For 
written permission, please contact apache@apache.org. 
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5. Products derived from this software may not be called “Apache”, nor may “Apache” 
appear in their name, without prior written permission of the Apache Software 
Foundation. 

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR 
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf of 
the Apache Software Foundation and was originally based on software copyright (c) 1999, 
International Business Machines, Inc., http://www.ibm.com. For more information on the 
Apache Software Foundation, please see http://www.apache.org/. 

Netscape License Agreement
ISE release 10.1 contains “remote.c” code licensed from Netscape Communication 
Corporation under the following terms: 

/* -*- Mode:C; tab-width: 8 -*- 
remote.c --- remote control of Netscape Navigator for Unix.
version 1.1.3, for Netscape Navigator 1.1 and newer.

Copyright © 1996 Netscape Communications Corporation, all rights reserved.
Created: Jamie Zawinski <jwz@netscape.com>, 24-Dec-94.

Permission to use, copy, modify, distribute, and sell this software and its documentation 
for any purpose is hereby granted without fee, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this permission notice appear 
in supporting documentation. No representations are made about the suitability of this 
software for any purpose. It is provided “as is” without express or implied warranty.

Info-ZIP License Agreement
ISE release 10.1 contains Info-ZIP software licensed from info-zip.org under the following 
terms:

This is version 2002-Feb-16 of the Info-ZIP copyright and license.

The definitive version of this document should be available at ftp://ftp.info-
zip.org/pub/infozip/license.html indefinitely.

Copyright (c) 1990-2002 Info-ZIP. All rights reserved.

For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of 
individuals:

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, 
Hunter Goatley, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, 
Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, 
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Igor Mandrichenko, Steve P. Miller,Sergio Monesi, Keith Owens, George Petrov, Greg 
Roelofs, Kai Uwe Rommel,Steve Salisbury, Dave Smith, Christian Spieler, Antoine 
Verheijen,Paul von Behren, Rich Wales, Mike White

This software is provided "as is”, without warranty of any kind, express or implied. In no 
event shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, 
special or consequential damages arising out of the use of or inability to use this software.

Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the following 
restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, 
disclaimer, and this list of conditions.

2. Redistributions in binary form (compiled executables) must reproduce the above 
copyright notice, definition, disclaimer, and this list of conditions in documentation 
and/or other materials provided with the distribution. The sole exception to this condition 
is redistribution of a standard UnZipSFX binary as part of a self-extracting archive; that is 
permitted without inclusion of this license, as long as the normal UnZipSFX banner has not 
been removed from the binary or disabled.

3. Altered versions--including, but not limited to, ports to new operating systems, existing 
ports with new graphical interfaces, and dynamic, shared, or static library versions--must 
be plainly marked as such and must not be misrepresented as being the original source. 
Such altered versions also must not be misrepresented as being Info-ZIP releases--
including, but not limited to, labeling of the altered versions with the names "Info-ZIP" (or 
any variation thereof, including, but not limited to, different capitalizations), "Pocket 
UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such altered 
versions are further prohibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-
mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," 
"WiZ," "Pocket UnZip," "Pocket Zip," and "MacZip" for its own source and binary releases.

bgexec License Agreement
ISE release 10.1 contains bgexec software licensed from sourceforge.net under the 
following terms:

BSD License. Here is licensing info present in all the .h and .cpp files 

blt.h --

Copyright 1991-1998 by Bell Labs Innovations for Lucent Technologies.

Permission to use, copy, modify, and distribute this software and its documentation for any 
purpose and without fee is hereby granted, provided that the above copyright notice 
appear in all copies and that both that the copyright notice and warranty disclaimer appear 
in supporting documentation, and that the names of Lucent Technologies any of their 
entities not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission.

Lucent Technologies disclaims all warranties with regard to this software, including all 
implied warranties of merchantability and fitness. In no event shall Lucent Technologies be 
liable for any special, indirect or consequential damages or any damages whatsoever 
resulting from loss of use, data or profits, whether in an action of contract, negligence or 
other tortuous action, arising out of or in connection with the use or performance of this 
software.
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CURL Library License Agreements
The ISE release 10.1 Webinstall and WebUpdate use the CURL library which is licensed 
under the following terms:

CURL COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1996 - 2005, Daniel Stenberg, <daniel@haxx.se>.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or 
without fee is hereby granted, provided that the above copyright notice and this 
permission notice appear in all copies.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in 
advertising or otherwise to promote the sale, use or other dealings in this Software without 
prior written authorization of the copyright holder.

The CURL library shipped with ISE release 9.2i uses the zlib library which is licensed 
under the following terms:

Zlib license

zlib.h -- interface of the 'zlib' general purpose compression library

version 1.2.2, October 3rd, 2004

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will 
the authors be held liable for any damages arising from the use of this software. Permission 
is granted to anyone to use this software for any purpose, including commercial 
applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment in 
the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org
Mark Adler madler@alumni.caltech.edu

The CURL library shipped with ISE release 9.2i uses the OpenSSL Toolkit which is licensed 
under the following terms (both licenses apply:)
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iText License Agreement
The iText module (http://www.lowagie.com/iText/) is licensed to Xilinx and to you 
under the Mozilla Public License 1.1 that may be seen at: 
http://www.lowagie.com/iText/MPL-1.1.txt. The ChipScope Pro Analyzer waveform 
print menu option uses the iText module to implement the PDF writer feature.

JDOM License Agreement
The JDOM module (http://www.jdom.org) is licensed to Xilinx and to you under the 
terms listed in the license agreement that can be found in the Apache-style open source 
license file that is found at: <install_dir>/bin/<platform>/JDOM_LICENSE>TXT (where 
<install_dir> is the ChipScope Pro installation directory and <platform> is one of nt, nt64, 
lin, or lin64, depending on the system platform type). The ChipScope Pro tools use the 
JDOM module to parse XML files.

Java Runtime Environment (JRE) License Agreement
The JRE module (http://java.sun.com) is licensed to Xilinx and to you under the terms 
listed in the Sun Microsystems, Inc.Binary Code License Agreement that can be seen at: 
http://java.sun.com/j2se/1.5.0/jre-1_5_0_14-license.txt. Also, the license agreement can 
be found in the file called <install_dir>/bin/<platform>/jre1.5.0/LICENSE (where 
<install_dir> is the ChipScope Pro installation directory and <platform> is one of nt, nt64, 
lin, or lin64, depending on the system platform type). The ChipScope Pro tools use the JRE 
to run the Java-based application programs.

OpenSSL License
Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the 
following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit. (http://www.openssl.org/)”

4. The names “Opens Toolkit” and “OpenSSL Project” must not be used to endorse or 
promote products derived from this software without prior written permission. For 
written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” 
appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit (http://www.openssl.org/)”
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THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). 
This product includes software written by Tim Hudson (tjh@cryptsoft.com).

SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The 
implementation was written so as to conform with Netscapes SSL. This library is free for 
commercial and non-commercial use as long as the following conditions are adhered to. 
The following conditions apply to all code found in this distribution, be it the RC4, RSA, 
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson 
(tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to 
be removed. If this package is used in a product, Eric Young should be given attribution as 
the author of the parts of the library used. This can be in the form of a textual message at 
program startup or in documentation (online or textual) provided with the package. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions 
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the 
following acknowledgement:

“This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com)” 

The word 'cryptographic' can be left out if the routines from the library being used are not 
cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps 
directory (application code) you must include an acknowledgement: “This product 
includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
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PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this 
code cannot be changed. i.e. this code cannot simply be copied and put under another 
distribution licence [including the GNU Public Licence.]

ISE release 9.2i contains software licensed from Kevin Tao and Jens Palsberg under the 
following terms:

All files distributed in this package are Copyright (c) 1997-1998 by Kevin Tao and Jens 
Palsberg, Purdue University Department of Computer Science. ALL RIGHTS RESERVED.

Permission to use, copy, and distribute this software in its entirety for commercial or non-
commercial purposes and without fee, is hereby granted, provided that the above 
copyright notice and this permission notice appear in all copies and their documentation.

This software is provided “as is” without expressed or implied warranty of any kind. 

You may not “bundle” and distribute this software with commercial systems and/or other 
distribution media without prior consent of the authors.

Some files in this package have been modified by software developers at Xilinx, Inc. 1998, 
and as modified this package may not be distributed outside Xilinx.

ABC License Agreement
XST and MAP in ISE release 10.1 software use the ABC Logic Synthesis and Verification 
System software from UC Berkeley which is licensed under the following terms: 

Copyright © The Regents of the University of California…..(etc)

Open LDAP License Agreement
ISE release 10.1 contains software licensed from the Open LDAP foundation under the 
following terms:

The OpenLDAP Public License

Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation (“Software”), with 
or without modification, are permitted provided that the following conditions are met:

1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and 
notices, this list of conditions, and the following disclaimer in the documentation and/or 
other materials provided with the distribution, and

3. Redistributions must contain a verbatim copy of this document. The OpenLDAP 
Foundation may revise this license from time to time. Each revision is distinguished by a 
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version number. You may use this Software under terms of this license revision or under 
the terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS 
CONTRIBUTORS “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS 
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

The names of the authors and copyright holders must not be used in advertising or 
otherwise to promote the sale, use or other dealing in this Software without specific, 
written prior permission. Title to copyright in this Software shall at all times remain with 
copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All 
Rights Reserved. Permission to copy and distribute verbatim copies of this document is 
granted.
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